DEA 2730: Human Centered Design Methods | course site

- 3 credits; letter grade only; no final exam
- Enrollment limited to 24 students; priority given to DEA undergraduate majors; otherwise by permission (MAE and IS students are given preference given my affiliations with these).
- Prerequisites for DEA students are DEA 1101 and 1150; others by permission

Keith Evan Green, RA, PhD | Professor, HCD, MAE, IS | keg95@cornell.edu, office hours tbd, MVR 2421

NOTE: The most current documentation for this course is found online at https://arl.human.cornell.edu/DEA2730%20HCDM.htm. This pdf is for basic information; some aspects (e.g., grading, policies) may not be current.

1. Course Description (50 words)
This course explores the use of design methods to generate ideas and evaluate designed objects, environments, and interfaces. Lectures cultivate an understanding of the various methods, while hands-on activities provide opportunities to apply these methods to the design of artifacts and their interactions with people and things.

2. Background and Definitions
"Human-Centered Design Methods" (HCDMs) focuses on the iterative, design-research process used to design and evaluate objects and environments. HCDMs are not only used to design things, but also to design the interactions between things and the people who use them and live in them. An "Interaction Designer" is the title of a designer who designs things and their relationships with other things, including people. As follows, Interaction design is not only about form-making and composition; it is moreover about creative and meticulous design, it's about technology, and it's about an attentiveness to the needs and opportunities of people and the planet, striving to improve lives, enhance existing places, and support interactions of human beings with their physical and digital surroundings. This course, in particular, focuses on designing interactive artifacts more than static artifacts, as interactive artifacts with embedded digital technologies are growing in number, kind, and complexity.

WHAT TO DO FIRST
- Listen to "The Power of Design" and "Are the Best Designers Rebels?" on the TED RADIO HOUR.
- Explore examples of interactive devices for inspiration.
- Learn from Julie Zhao, Facebook's young VP of Product Design who explains what Facebook looks for when hiring designers, how designers can best start their careers, and how to pitch a compelling vision.

3. Learning Outcomes
Three learning outcomes are expected of this course:
Outcome 1 To develop an understanding of how and which design methods can be applied in the iterative process of designing an artifact.
Outcome 2 To demonstrate the ability to develop and evaluate design prototypes responsive to the challenges and opportunities of society.
Outcome 3 To communicate a design process in a paper and video (that satisfy the requirements of a benchmark, design-research conference).
**WHAT ARE WE DESIGNING?**

In this course, we are iteratively designing and evaluating a small, interactive artifact as defined by our DESIGN CHALLENGE (see the description of this challenge in the narrow column on the upper-left of this webpage). We are designing this artifact as a means to practice the numerous ideation strategies and evaluation methods that define this course. The design requires more smarts than labor and expensive materials, so “think different”! While some class time will be devoted to workshop activity during which students design and evaluate their interactive artifacts, in-class workshop activity is brief and you will need to work outside class.

**In more practical terms, what are we designing?**

- A small physical object that is three dimensional (i.e. not a screen).
- An object that is interactive - that may light up, change color, make sounds, and/or move or change shape - when someone does something (near or far from it) or something happens (near or far from it). The practice of designing interactive artifacts is often referred to as interaction design or physical computing.
- An object that provides an experience that impacts behavior, characterized as persuasive technology fostering sustainable behavior, or what has been called earth stewardship.
- An object that is not only impactful but also playful, fun, whimsical; an object that provides *an experience worth talking about*.
- An object that is more like a jack-in-the-box and less like a number counter, a measuring scale, a thermometer, and other measuring devices.
- An object that might have market value. The [lovebox](link) is a good example of the kind of product we are striving for: small in scale, whimsical/poetic, beautifully crafted, interactive, meaningful/purposeful, and kinetic. Spend time reviewing, also, example interactive artifacts from the Demo Hour of Interactions; and projects from TU Delft’s Interactive Environments program. You might also find inspiration and ideas from Make ([link](link)).

### 4. Course Materials

- 1 Sketchbook like this one ($12.96) or similar found in our bookstore or otherwise.
- 1 Grove Beginner Kit for Arduino ($19.99) from SEEED, DigiKey, Mouser, Amazon. SEEED, the manufacturer of Grove products, offers us an educational discount of 10% on its products (using code: SeecedXXXx - ask me in class to fill-in the Xs). The Grove Beginner Kit makes your design interactive (See: Kit intro video; Kit web page; Grove Beginner Kit for Arduino User Manual). If you are outside the USA, see bottom-left of this page for ordering suggestions. At the bottom of this page are numerous resources for how to work with Grove and Arduino.

  - The Pocket Universal Methods of Design: 100 Ways to Research Complex Problems,... (ISBN-10: 1631593749; $13 +/‐) from the Cornell Bookstore or from Amazon.. Please do not purchase the similarly titled, The Pocket Universal Principles of Design: 150 Essential.....

- 1 Grove Servo ($5.90) available from SEEED, Mouser, Amazon. If you order from Seeed, don’t forget to use the discount code when ordering.

- 1 Grove Ultrasonic sensor ($3.99) available from SEEED, DigiKey, Mouser, Amazon. If you order from Seeed, don’t forget to use the discount code when ordering.

- Any 1 of these Grove light modules: RGB LED Stick (10 - WS2813 Mini) 3-1/4” long ($4.90), or RGB LED Ring (16-WS2813 Mini) 2-1/4” ($6.90), or Variable Color LED ($3.90) or Chainable RGB Led V2.0 ($5.99) available from SEEED, Mouser, Amazon. If you order from Seeed, don’t forget to use the discount code when ordering.
• Aluminum foil - 1 roll, any brand, as used in your kitchen (example).
• Cardboard from boxes, plastic from fruit and vegetable containers, and craft materials needed to construct your prototypes. Many of these materials you have already, like cardboard from boxes, plastic from fruit packaging; paper and glue. Other sources for materials are the Cornell Bookstore, Michael's at Ithaca Mall, and online at Utrecht, Blick, and Amazon.

5. Required Readings
• *The Pocket Universal Methods of Design: 100 Ways to Research Complex Problems,...* (readings are assigned by method number, e.g. 01, 16).

• Interaction Design (readings are assigned by chapter number, e.g. Ch.1, to p. 56).

• The Delft Design Guide (readings are assigned by letter linked from this page, e.g. A. Since the publication of the Guide as a printed book, a Wiki has been developed which expands and updates the print edition. The Wiki is part of a large TU Delft Industrial Design Engineering Wiki that is an ample resource for design methods, design tutorials (e.g. for Rhino), design conferences and journals, design definitions, design components, ...

The shorter publications:
• Carrol, J. M. Scenario-Based Design.
• Dow, Steve. *Wizard of Oz Interfaces* [WOz].
• Frayling, C. Research in Art and Design [RtD].
• Gaver, B. Cultural Probes.
• Mau, Bruce. An Incomplete Manifesto for Growth.
• Nornman, D. et al. Human-Centered Design Considered Harmful.
• Perec, G. *Observational "Experiments" in Species of Spaces and Other Pieces*.
  * Saldaña, J. *The Coding Manual for Qualitative Researchers*.
• Thomsen, D. Why Human-Centered Design Matters.
• van den Hende, E. and Schoormans, J. P. L. *The Story Is As Good As the Real Thing*.
• Zimmerman, J., Forlizzi, J. and Evenson, J. Research through Design [RtD].

A useful, online resource for HCD research methods: designresearchtechniques.com

6. Grading / Note the Grading Rubric.
The assignments are all individual efforts, not team or group work; however, you will be working in parallel with your peers all semester, to exchange ideas and inform one another’s human-centered design and evaluation activity. Throughout this course—an intimate and intensive “conversation” across students, professor, and TA—students will have ample opportunity to receive feedback on their work. Students will receive a grade in response to work, weighted as follows:

• [10 points] Completion of Cornell IRB training for human participant studies.
  From the Cornell IRB CITI link, follow this path to select the training:
  Take CITI Training > View Courses > "Role in Human Subject Research" [pulldown] Research Assistant and "Which courses do you plan to take?" [pull-down] Basic Human Subjects – Social & Behavioral Focus.
  Email the completion certificate to the TA before Thanksgiving break. Failure to complete this task or late submission results in a zero grade for this component of the course. No excuse.
  > What is the point of this? *To become ethical designers who respect human participants engaging in our design research activities.*

• [10 points] Ideation [Grading Rubric].
(1) upload to our shared folder and present in class 7 Powerpoint slides or pdf pages, with each slide/page showing your manifestations (i.e. your creations) of each of the ideation strategies 01-07 (see the upper-left of this webpage for these). You are encouraged to have more than one manifestation of some or all of the 6 ideation strategies, so that you will place several (e.g moodboards) on one slide. For you prototyping slide, you will show at least 10 manifestations.

(2) upload to our shared folder and present in class your paper in the correct format showing (for now) a complete title, draft abstract, and draft Introduction with its lit review for the problem you are addressing and the related, priorwork of others responsive to this problem.

> What is the point of this? To have an early practical experience using ideation strategies so you can draw on these as you develop your designed artifacts for this course and beyond; to begin communicating to an audience a cohesive early concept for your design supported by your ideation strategy production.

• [10 points] Concept [Grading Rubric].

(1) upload to our shared folder a name for your prototype, a money shot, a "demo" of your design captured by video, and 4 Powerpoint slides or pdf pages, with each slide/page showing your one best manifestation of 08-11 as listed in the narrow column on the upper-left of this page.

(2) upload to our shared folder a print ad for your concept to appear in WIRED magazine (size 8" by 10 7/8"). If you do not have a suitable Adope product to create this print ad, Paint.net is a free image and photo editing app for Windows.

Note: You may want to add a remote environment (e.g. a Parisian café, an assistive living unit, a museum lobby) as a preferred physical context for your design; however, such an environment is not readily accessible to you. An easy strategy for adding this physical context is as follows: video record your working prototype (with “actors” or scale figures of people if your prototype is to-scale) on a white background (e.g. in front of a white wall); then, add your background context photo (e.g. a photo of the café) as a virtual background in Zoom and record your screen.

> What is the point of this? To "sell us" on your design concept, as if we were your clients or your investors.


To create functioning, interactive prototypes, you are required to embed into your prototype Grove electronics (see the Grove Beginner Kit for Arduino User Manual). Your prototype with embedded Grove modules will have at least 1 input and 1 output:
• at least one Input (a sensor, such as a motion sensor or a light sensor)
• at least one Output bit (an actuator, such as an LED or a servo motor)
Each student will receive a grade for her/his prototype, as presented at the final demo/video.

> What is the point of this? To "sell us" on your meticulous, thoughtful, iterated, and thoroughly documented, designed artifact.

• [10 points] Self-Critique Essay. Each student uploads to our shared folder a “self-critique” essay that responds to the question, How does my paper for this course compare - in depth, presentation, quality - to the model paper, ReWear? Use the Grading Rubric for the paper as a guide to make your assessment. This essay is due on or before DEA’s deadline for final deliverables that include your paper and video. This essay is 1-3 pages.
> What is the point of this? To become an informed, critical and self-reflective designer informed by the best work of others.

- **[10 points] Attendance and participation.** Attendance will be taken by the TA in the first 10 minutes of class. *Failure to attend a class without an approved excuse that was submitted by email prior to that class will lower your grade 2 points out of 100 points total.* Participation is graded by the quality of your contributions in class, mostly when randomly selected to (a) serve as a design critic responding to peer projects; and (b) present their work to the class for class critique.

- **[30 points] Final Course Deliverables [Grading Rubric].** Each student: (a) uploads to our shared folder and (b) presents in class: a paper and a video. Each student will make her or his assignment clear to the instructor for the purpose of grading by uploading her/his work with file name in this format: *MyName-Paper*. *Failure to concisely organize your uploaded digital files will lower your course grade 2 points out of 100 points total.*

> What is the point of this assignment? To thoroughly document your meticulous, thoughtful, iterated, designed artifact, mindful of the three objectives of the course.

More about the two key deliverables for this course, submitted by each student:

1. **A paper** [my guide] communicating the iterative, human-centered design process for your development of an interactive artifact. You are not reporting on all ideation strategies and design research methods; only those that make the most cohesive, compelling reporting of your design process. This paper will adhere to the requirements for a *Late-Breaking Workpaper submission* to the conferences DIS (Designing Interactive Systems) and CHI (Human Factors in Computing Systems). *My version of the ACM template offers my suggested headings and explanation of each part of the paper along with instructions from ACM on formatting your paper (mostly by cut-and-paste).* Your paper will be (no more than) **eight pages, excluding** (an unlimited number of) pages for **references**. You are encouraged to learn from prior Works in Progress papers linked to this course web page (see above) and those found (in the thousands) in the ACM DL.

2. **A video** [my guide] communicating the full, cohesive story of the designed artifact you produced, answering why, for whom, and how it was developed, including briefly key findings of your user studies. For the video, **include in your paper a URL link** to your video in Vimeo or YouTube; and upload to our shared folder an **MP4 file reduced to < 30MB** using, eg. Handbrake (see my video guide). The video will otherwise adhere to the requirements for the **Video Showcase submission** to the ACM conference CHI (a benchmark for design research), where you will also find example videos. NOTE: If you do not have iMovie on a Mac to edit video, **Open Shop** is an excellent video editing app that’s free for Windows.

7. **Policies**

**Required:** attendance, timely arrival to class, participation, and the uploading of all documents to the course Box or Google Drive folder strictly adhering to all formatting requirement and specifications detailed here, on the course webpage, and in the ACM conference website(s). Failure to fulfill these requirements will reduce your grade up to 10% of the total grade at the discretion of the instructors. Attendance at the start of class will be taken for some class sessions without advanced notice. For each absence or late arrival, **email the professor and TA with an explanation**, attaching supporting documentation (e.g. doctor’s note); these will be considered as a valid excuse (hardship, medical appointment) without penalty, **or not**. It is your education, so you should take responsibility for yourself in attending all class sessions on time.

**Late submissions will NOT be accepted**, except with a doctor’s note or other proof of personal crisis or hardship. Failure to submit the printed documents and digital files on-time will reduce your final assignment grade 10 points.
Grading for this course is carefully determined by the professor (and TA, if any) with thoughtful consideration of student grading by your peers. If you believe the grade for any component of this class including the final grade is incorrect, you may submit a written argument along with the component-in-question for reassessment. The written argument must reference a specific issue with the graded component of the course and must be thoroughly substantiated. The professor (and TA, if any) will together consider the request, potentially with the assistance of other faculty with expertise in the area. The reassessment will result in any of the following outcomes: no change of grade, a change of grade for the better, or a change of grade for the worse. You understand that the grade for work submitted for reassessment may result in a grade lower than originally assigned.

8. Consent
To prepare the required paper and video for this course, enrolled students may conduct peer-to-peer participant studies using their peers as participants. Methods may include interviews, observations, surveys, co-design activity, heuristic evaluations, and cognitive walkthroughs. As part of this design research activity, students conducting these studies may take written notes, photographs, and/or video as a means of documentation. This documentation may appear in papers, videos, and conferences for academic audiences. Student will not be identified by name, and no aspect of these studies should cause discomfort or risk to participants. Should any student in the class choose not to participate in any aspect of the study, or have questions about her/his participation, please make this known to the instructor. Additionally, for any work of the course submitted for publication, student authors will be identified as first authors of the submission, and the instructor and TA will follow in the list of authors of such work in recognition of their efforts in cultivating this work. If these terms are not acceptable to you, please indicate so to the instructor. Non-participation will not impact your grade for this course in any way.

9. University Statement on Academic Integrity and Honesty
Each student in this course is expected to abide by the Cornell University Code of Academic Integrity. Any work submitted by a student in this course for academic credit will be the student’s own work, except in the cases of projects that are specifically structured as group endeavors. In compliance with the Cornell University policy and equal access laws, the faculty, teaching assistants, and teaching associates for this course are available to discuss appropriate academic accommodations that may be required for students with disabilities. Requests for academic accommodations are to be made during the first three weeks of the semester, except for unusual circumstances, so that arrangements can be made. Students are encouraged to register with Student Disability Services to verify their eligibility for appropriate accommodations.

10. DEA Statement on Academic Integrity and Honesty
DEA is dedicated to fostering a respectful and accepting learning community in which individuals from various backgrounds, experiences, and perspectives can embrace and respect diversity. Everyone in this community is empowered to participate in meaningful learning and discussion, regardless of an individual’s self-identified gender, sexual orientation, race, ethnicity, religion, or political ideology. We encourage students to share their uniqueness; be open to the views of others; honor and learn from their colleagues; communicate in a respectful manner; and create an inclusive environment.
11. **Schedule**

**NOTE:** This pdf file for the syllabus presents a typical schedule; however, the active and most complete schedule for this course is found in the course guide provided online at https://arl.human.cornell.edu/DEA2730%20HCDM.htm.

Most class sessions begin with a video case-study from ACM Demo or like.

**01 Course Organization and Definitions**
> READ: this course webpage.
> ACTIVITY: listen, hand-write notes, ask questions; purchase the Grove kit.

**02 Introduction and Definitions-1 | Mind Mapping**
> READ: Ch.1; 02; 56; Des. Cycle; “Working From Home”; “Space”; “May AI Help?”
> ACTIVITY: Mau’s "An Incomplete Manifesto"; ideate with MindMap.

**03 Introduction and Definitions-2 | Lit Review**
> READ: Ch.9; Problem Definition; Requirements; Lit Review
> ACTIVITY: define your problem; search ACM DL; draft your lit review in Word or like.

**04 Research through Design [RtD] | Model Paper:** U MD Coll. Park, ReWear
> READ: 70. RtD; Frayling Research; Zimmerman RtD; Paper template.
> ACTIVITY: Refine your lit review for problem and prior work and enter into template.

**05 Cultural Probes**
> ACTIVITY: Create a cultural probes package, distribute it, and plan for its return.

**06 Interviews with Stakeholders, and How To Code Them**
> READ: Ch.13 to p. 398; 43; 48; Interviews; Focus Groups; The Coding Manual.
> ACTIVITY: conduct an interview with 5 participants; analyze the interviews, focused on user experience with and user response to design alternatives.

**07 Prototyping-1: Rapid Prototyping**
> READ: Ch.8 to p. 268; 11, 53; Prototyping; The Story Is....
> ACTIVITY: make 10 prototypes with craft materials, start with foil and cardboard.

**08 Mood Boards**
> READ: Ch.5 to p. 147; 14; 47; 66; 99; Mood boards.
> ACTIVITY: ideate with a mood board - example from previous class.

**09 Storyboards**
> READ: 58; 82; Storyboard (more; example from cinema).
> ACTIVITY: ideate with storyboards - ex.1, 2 from class; user-study with storyboards.

**10 Prototyping-2: with GIFs**
> VIEW: PBS video: GIF; Photoshop GIF; Powerpoint GIF
> ACTIVITY: Prototype with GIFs - ex.s 1, 2, 3, 4; 5, 6; 7; 8
11 **Presentations [Present: Ideation]**

> ACTIVITY: present your ideation strategies 1-5 (one strategy per slide) in 3 minutes.

12 **Scenarios and Role Playing [DUE: Ideation: 10 pts]**

> READ: 71; 72; 73; 84; Scenario (more); Scenario-Based Design; Role Playing.

> ACTIVITY: draft a scenario - ex from communIT; role-play with your prototypes.

13 **Prototyping 3: with Grove hardware**

> READ: Ch.11; The Grove Beginner Kit for Arduino User Manual; WOzZ (for 1st time).

> ACTIVITY: prototype with Grove.

14 **Ethnography, Triangulation**

> READ: Ch.12; 42; 57; 59; 61; 91; Observations; Perec's Observational Experiments

> ACTIVITY: conduct an observation with your developing prototype.

15 **Morphological Charts**

> READ: 36; Morphological Chart: 1, 2, 3, and a student example from class.

> ACTIVITY: ideate with a morphological chart; select cells to generate alternatives.

16 **Prototyping-4: Wizard of Oz (WOz) prototyping and interfaces**

> READ: 53; WOz once again!; An example (Nest); Marvel app.

> ACTIVITY: prototype with Grove; consider what you can make function/what to WOz.

17 **Surveys, In-person and Online**

> READ: Ch.13 pp. 398-407; 23; 97; 67; 83; Surveys; Tool to calculate sample size.

> ACTIVITY: review survey examples below; use Google Forms (help if needed) or (more advanced) Qualtrics, Survey Monkey, or Mechanical Turk to generate an online survey focused on user experience and user response to design alternatives; conduct your survey with at least 5 participants; analyze, reflect, and iterate your prototype.

18 **Think-Alouds, Cognitive Walkthroughs, 3 Types of User Studies**

> READ: Ch. 13 pp. 407-412 and 419-425; 13; 46; 87; Methods Compared

> ACTIVITY: perform a Think-Aloud with 5 participants, analyze, reflect, and iterate.

19 **Prototyping-5: Money Shots & High-Fidelity**

> VIEW: Steve Jobs on presenting to an audience in spoken words and images.

> ACTIVITY: generate your money shots - ex.s 1, 2, 3, 4); example of hi-fi prototype.

20 **Does HCD matter or does HCD do harm? [DUE: IRB course: 10pts]**

> READ: "Why HCD Matters" and "HCD Considered Harmful"

> ACTIVITY: Debate the merits of HCD: Where, why, and when does it work and not?

21 **Presentations [Concept, including a working prototype and print ad]**

> ACTIVITY: pitch your design in 3 minutes as if we were your clients or your investors.

1. Describe the problem you’re solving.
2. Describe who/how many people have this problem.
3. Talk about the experience, not the product.
Present what makes your case. You don’t have time to present all slides for 6-12, but these slides are part of your deliverables uploaded by next deadline (as below).

22 **Usability Studies, Heuristics** [DUE: Concept: 10 pts]
> READ: Ch. 14 to p. 447; 93; 94; M Heuristic Eval., *(Nielsen's Heuristics)*, SUS
> ACTIVITY: perform a Standardized Usability Study (SUS) *(my version)* with at least 5 participants; score/analyze *(how to score)*, reflect, iterate.

23 **Delphi Method, Quasi-Experiment Studies**
> READ: The Delphi Method; V Videos - see examples below.
> ACTIVITY: perform a Delphi Method study with 3-5 members of class as participants, focusing on one or more unresolved aspects of your design; analyze, reflect, iterate.

24 **Interaction Design in Practice; IRB; Agile UX [Course Evaluations]**
> READ:The IxDA (Interaction Design Association) webpages.
> ACTIVITY: iterate!; complete the online course evaluation for DEA 2730.
12.10 | 25 Demos, Papers and Video Showcase
> BEFORE CLASS, organize on your computer: (a) a Word doc with your URL (YouTube or Vimeo) linking to your draft video; (b) your draft paper as a pdf.
> BRING TO CLASS: your working prototype.
> ACTIVITY: You will 1st - play your video, 2nd - demo your prototype [20 pts], and 3rd - quickly display your paper.

25 **Demos, Papers, and Video Showcase**
> BEFORE CLASS, organize on your computer: (a) a Word doc with your URL (YouTube or Vimeo) linking to your draft video; (b) your draft paper as a pdf.
> BRING TO CLASS: your working prototype.
> ACTIVITY: You will 1st - play your video, 2nd - demo your prototype [20 pts], and 3rd - quickly display your paper.

26 **Demos, Papers, and Video Showcase**
> BEFORE CLASS, organize on your computer: (a) a Word doc with your URL (YouTube or Vimeo) linking to your draft video; (b) your draft paper as a pdf.
> BRING TO CLASS: your working prototype.
> ACTIVITY: You will 1st - play your video, 2nd - demo your prototype [20 pts], and 3rd - quickly display your paper.

**By Monday Dec. 21, 9am | [UPLOAD ALL FILES (as below, red type)]**
Your grades for the Self-Critique Essay and the Final Course Deliverables (described below) are based on what we find from you in our shared file at this date and time. Remember to label your uploaded file with your name and deliverable (i.e., MyName-paper.pdf and MyName-video.doc where this Word doc has the URL to your posted video).
APPENDIX

DIGITAL FABRICATION: SOFTWARE & D2FS
This course does not require the use of digital fabrication to produce the prototype. You can manually produce all deliverables for this class. Many students use Adobe Photosho or a like app, but even this is not a course requirement.

It’s however easy to digitally fabricate components for your prototypes. Our partners for this course are the staff or our very friendly and capable Digital Design Fabrication Studio ("D2FS") on LL2 in HEB adjoining MVR. D2FS staff in the shop in HEB 2L31. You can easily draw a 2D file of your component(s) for laser cutting by our D2FS staff. Use Adobe Illustrator (save as ai) or use a CAD program like SketchUp (save as DXF) which is free and very simple to use.

• Preparing files for 3D printing can be more difficult, but if they are simple geometries, you can again use SketchUp. If you need a more complex form, you might begin by seeking the file you need from repositories of 3D printing files like this one and this one.

If you need to create a form anew or modify an existing file, the standard application to do so in industrial design/architecture is Rhino, and in Engineering, Solidworks (both are available on the computer in the rear of the "Assembly Room,' HEB 2L32). Typically, files are saved as stl for 3D printing. Work with the D2FS staff on your 3D printing projects.

• Once you have saved your file for laser cutting (ai or DXF file) or 3D printing (stl file), "Request an Appointment" to submit your file and specifications for digital fabrication, and the staff will do the work for you, presenting to you ASAP the fabricated pieces you requested. Make sure to complete the online appointment form carefully with precise specifications. If laser-cutting sheet materials are not provided by the class (e.g. for assignment 2), you will need to provide the staff with these sheet materials to laser cut ahead of your request. 3D printing materials are supplied free of charge.

• Work with the D2FS staff (ched2fs@cornell.edu) - they are here to help you!

CORNELL COLLABSPACE TUTORIALS
• Cornell Engineering with Instructables offer these tutorials on a variety of useful topics for this course, including 3D-printing and other digital fabrication means.

EXAMPLE PROTOTYPES
• An inventory of interactive artifacts from "Interactions" magazine of ACM SIGCHI.
• The classic example: musicBottles (Hiroshi Ishii, Tangible Media Lab, MIT).

EXAMPLE IRB AND CONSENT FORMS
IRB application from my lab
IRB approved protocol from my lab
Parental Permission (Consent) Form - example from my lab

EXAMPLE SURVEYS
Survey (for children) with Smileyometers (from my lab)
Survey (for adults) showing two different kinds of Likert scales

EXAMPLE VIDEOS & MY GUIDE
Example from previous students in DEA 2730: Xtinguish
Example from previous students in my DEA 5210 studio: Helping Hand
Example from previous students in my DEA 6210: GrowBot BEST DEMO, ACM IDC

EXAMPLE PAPERS
ReWear from University of Maryland College Park OUR MODEL PAPER
H2GO from previous students in DEA 2730 (but note in the pdf my comments in red)

USING GROVE
• My Powerpoint Slides to get Started with Grove - start here ...
• Project Examples from Grove
• Project examples from "Instructables" with code and documentation.
• Project examples from Arduino Project Hub
• Numerous Grove Tutorials.
• Many more Grove components are available than found in the kit.

CODE IN THE ARDUINO SOFTWARE - easy
• You can find lots of code already built into the Arduino software (IDE): Open up Arduino, select File > Examples, select an example and it will open in an Arduino window, ready to upload to your Arduino board!
• All of the built-in examples are thoroughly described here. Follow their logic to construct your code for your project.

CODE EXAMPLES TO GET YOU STARTED - best bet
• A light sensor makes a servor motor rotate: code
• A light sensor makes a buzzer play a song: code
• A light sensor makes a servor motor rotate and controls an LED strip: code
• A button makes a servor motor rotate and controls an LED strip and an LCD: code
• Multiple touch sensors control LED strips, a buzzer, and an LCD: code

CODE IS FOUND ON GITHUB - for a deeper dive!
• GitHub is the open-source repository of code, including code for Grove Arduino. Enter a GITHUB search for the code you’re seeking, copy it, and paste it into the Arduino window (over-writing any sketch code you may find in the window).